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The latest news and tips from ShareScope

ShareScoop
Dear Member

As usual we have been working hard to further enhance ShareScope. At the beginning of the year we 
added a host of additional fundamental values and, in GM’s column, Tim Clarke discusses some interesting 
alternatives to the PE value. We hoped by now to have added a new portfolio performance reporting 

feature but this has taken longer than expected - so please bear 
with us! We are also working on a revamped Data Mining (stock 
screening) which will have a simpler interface and include all the 
new fundamental data items.

It’s that time of year when the FT/Investors Chronicle and 
Shares open the voting for their respective industry awards. 
As ever, we would be delighted to receive your vote for “Best 
Investment Software”. 
 

To vote in the IC awards, and enter a prize draw for £1,000, click here.  
To vote in the Shares awards, and enter a prize draw for an iPad, click here.

Free ShareScope Training
We offer a free training day for ShareScope Pro users at our offices in London. We are also happy to 
offer places to ShareScope Plus users if space is available. The courses are held once a month and run 
from 10am to around 4.30pm. You’ll get a comprehensive overview of ShareScope and the ability to 
have all your questions answered. If you would like to attend one of these sessions, please email 
training@sharescope.co.uk.

We recently held our first monthly webinar for new ShareScope Gold users. Our next webinar will 
take place at 7:30PM on Wednesday 30th July and existing users are also welcome. To register, 
simply email training@sharescope.co.uk and quote your name and/or account number. We’ll also 
record this presentation and make it available on our website.

We would welcome your feedback on future training topics - please email our training team with 
your suggestions.

Left-click column editing for Mac users
If you use ShareScope on a Mac via Parallels or some other emulation program, you might have 
encountered difficulties with context menus caused by the absence of a right mouse button. 

Most of these problems can be bypassed by using the various menus at the top of the screen, however if 
you wish to edit the columns in a list there is no way to do this other than with a right-click. With this in 
mind we have introduced an alternative way to right-click on column headings in ShareScope. 

To activate it, go to Tools > Options... > Lists and tick the Enable left-click menu on column headings option. 

To open a column context menu, point your mouse at the column heading area of a list and left-click on it, 
keeping the button pressed for about one second. 
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Results & Ratios – Multi-Year Averages
In many cases it is useful to analyse a particular performance metric over a multi-year period. For example, 
you might want to know the average PE over the last three years or the percentage EPS change over a five 
year period. Of course, you can add a column for each year but the Calculated options on the Add Results 
dialog enable you to condense this information into one column or item. 

Look at the example List box on the right for an idea of what can be 
achieved. As well as the current value for a range of metrics you can also 
see the five year average – helping you to judge whether the stock is 
valued higher or lower than “average”.
  
The Calculated options are available when adding Results columns to a 
table or adding items to List boxes in the Details view. 

There are three options:

• Growth %: the percentage change over the time period selected.

• Growth - annual %: the annualised percentage change over the time period selected.

• Average: the average value per year over the time period selected.

Note: The Growth options require the first and final years of the selected time period to be positive. If 
either year is negative, a percentage change will not be calculated.

Additional settings and layouts (ShareScope Plus & Pro only)
You can now create up to 100 settings in each view. On the Settings menu (e.g. Graph settings), select New 
setting or Copy this [setting] to....

You can also create up to 100 window layouts. On the Window menu, select Window layouts then New 
window layout. 



Phil’s Hidden Gems
You can now display the latest value for moving averages, indicators and their signal 
lines, channels and stop losses. These values will appear on the right-hand y-axis of 
your price or indicator charts. You can find these options on the Advanced tab of the 
Graph design... dialog.

Previously, a share could only be deleted from a portfolio whilst in the Portfolio view. 
This option is now available on the context menu in the Graph, Intraday graph and Details views (when the 
portfolio is the underlying list). Alternatively, press SHIFT-CTRL-DEL to delete the share whilst in these views. 
A confirmation dialog will be displayed before deleting the share.

Hold down the CTRL key when clicking on a layout button to display the same share in the new layout. The 
share needs to be present in the underlying list of the active window in the new layout. (Plus & Pro only)

You can now show a number of full days’ future on intraday charts. You will need to have at least a two day 
intraday chart for this option to be available. Right-click in the graph and select Show future > Show future 
settings.... (ShareScope Plus & Pro only)

Dividend History
The Dividend History view enables you to view an unadjusted history of dividends for any share. This is 
particularly useful for checking the actual dividends paid by stocks which have since undergone splits or 
consolidations (as ShareScope adjusts the dividends accordingly). For each dividend, the following items of 
data are provided: year end date, period end date, type of dividend, declaration date, ex-div date, record 
date, payment date, currency, actual value and adjusted value (where applicable). To display the Dividend 
History view, press SHIFT-D from any view in which a share is selected. 

Phil Tolhurst

Print layouts
You can now print an entire ShareScope Plus or Pro layout on a sheet of A4. Ideal if you want to share 
information with others (e.g. investment club) or customise a layout for creating printed reports (e.g. for 
clients). The printout will exclude extraneous details like window borders, scroll bars and close buttons. A 
high resolution image is saved to file in case you would prefer to import an image into a document. If you 
use ShareScope within a business, you can also import your company logo into a blank area of the layout. 
For more details, go to the Help menu, click on What’s New and follow the link for Print Layouts. 
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Note: we have a special offer for investment clubs. As long as one member of the club is an existing 
ShareScope member, we will waive the membership fee (£79.95) for other members of the club 
wishing to join.

Note: ShareScope Pro should not be used on a professional basis. ShareScope Pro contains real-time 
data for which the London Stock Exchange charges a higher fee in a professional investment, advisory 
or trading context. Please ask us about our professional product, Alpha Terminal.

Pairs Trading (ShareScope Plus & Pro only)
Pairs Trading involves taking opposite positions (long/short) on two closely correlated shares. The Pairs 
indicator enables you to directly compare the prices of two instruments in order to spot unusual deviations 
from their mean. Normally, two shares which are closely correlated (e.g. BP and Royal Dutch Shell) are used 
and deviations by the indicator from its normal range are looked for. At this point a long position is opened 
on the falling share and a short position is opened on the rising one, on the assumption that they will then 
return to their mean. 

At the end of October 2013, after a long period of trading at a ratio of around 0.205, BP PLC and Royal Dutch 
Shell PLC deviated significantly pushing their ratio to around 0.225. Note how BP rose sharply and RDSB fell.

According to pairs trading theory, two shares with very similar trading patterns will tend to return to 
their mean after a significant deviation. Here, a pairs trader would short the rising share (BP) and go long 
the falling one (RDSB). Both positions would be closed once the ratio returned to its normal level. In this 
example, the pairs trade would have resulted in a profit of over 9% (6.44% + 2.89%).

Pairs trading tends to work fractally, meaning that the theory tends to hold true irrespective of the chosen 
time frame.

Right-click in a Graph view, select Add Indicator then Pairs.... Click on the Help button in the dialog for 
guidance on the options presented.
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Keep window open
For a while now users of ShareScope Plus and ShareScope Pro have been able to float windows outside of 
the boundaries of the ShareScope program.  This has given them far greater flexibility when opting to run 
ShareScope on multiple monitors. In version 7.1.x, we went one stage further and allowed to set a window 
to ‘Keep window open’. 

Windows that are just floated are still part of the layout you have selected. Change layout and the window 
will disappear.  Switch back to the previous layout and the window will appear again.

Keep window open removes the connection between the floating window and the layout. So if you change 
layouts the window will be kept open. This can be useful, for example, if you want to float a chart of the 
FTSE 100 index and keep it on your secondary monitor at all times.

However, I’d like to explore another use for Keep window open that I can think of. Here, I’m running 
ShareScope on two monitors; they are actually different sizes. Being able float a window onto the left hand 
monitor is really useful - if I stretched ShareScope across the two screens it wouldn’t work particularly well 
due to the differing resolution settings of the two screens.

I have gone one step further here.  All of the windows on the right-hand monitor have been auto-linked so 
they are all showing details of whatever share I have selected in the floating window. However, the window 
on the left-hand monitor has been set to ‘Keep window open’. This means that I can change to another 
layout with autolinked windows (see below) and the selected share will be maintained.

Windows kept open like this are given a thin 
green border and the X button for closing 
the window changes to a red X on a pink 
background (see left).

This is just one use I can think of for the new 
Keep window open option. I am sure we have 
members who will find all sorts of interesting 
uses for this feature.
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I recommend that you have a good read through the Help pages for the fundamental 
data items we provide in ShareScope because not everything is provided on the 
default Details view. Search for Adding results & ratios in the Help facility.

In this issue of ShareScoop, I’m going to highlight a group of data values that can 
provide alternatives to the PE value.

As most of you will know:

GM’s Column

PE = share price (P) / normalised EPS (E)

Instead of EPS (post-tax earnings), some investors prefer to look at EBIT (earnings before interest and tax) or 
EBITDA (earnings before interest, tax, depreciation and amortisation).

EBIT shows the profit of the business before financing costs and taxation. It is useful for evaluating firms 
before the effects of different capital structures and tax rates. It is often quoted that EBIT is the same as 
operating profit but this is not strictly true. Operating profit includes any profits/losses from investments - 
such as rental income or businesses in which the company has a stake. These are removed in order to arrive 
at EBIT. Of course, where there are no profits/losses from investments, operating profit and EBIT will be the 
same.  

EBITDA goes one step further and adds back in the non-cash items of depreciation and amortisation. 
EBITDA is often used as an approximation for cash flow. EBITDA is calculated by removing cost of sales and 
administrative expenses from turnover. 

Selecting the Price to EBIT or Price to EBITDA options will give you an alternative to the PE value. You can 
choose to use normalised values as well. 

These alternatives change the E part of the PE ratio but we can also change the P.

Enterprise value (EV) is an alternative to market capitalisation which takes debt into account. In taking over 
a company, a buyer would have to take on its debts but would also gain its cash. Enterprise value treats 
net debt as an existing cost which will need to be paid. Using enterprise value in ratios provides a better 
comparison of companies with differing levels of debt. 

It is calculated as:

Enterprise value = Market capitalisation + debt and preference shares - cash and cash equivalents

Enterprise value enables us to calculate two further alternatives to the PE ratio: EV/EBITDA and EV/EBIT. 
These may suit investors who prefer to compare companies before financing, taxation and non-cash effects.

Let’s now look at Earnings Yield. This is the inverse of the PE ratio; it takes normalised EPS (E) and divides 
by the share price (P). Expressed as a percentage it enables comparison with bond yields and other types of 
investment.

In ShareScope, we also provide earnings yield calculated as EBIT/EV (a key component of the Greenblatt 
Magic Formula) and EBITDA/EV which is used by some as a measure of the cash return on an investment.

All of these options are available when you add a Results column in the List view, or add items to a List box 
or Results table in the Details view. As always, our Customer Support team can help you find and use these.
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Rich’s Scripts
Customising the Guru filters
As you are probably aware, a few months ago we introduced a number of filters to 
Data Mining which applied the techniques of various investment gurus like Jim Slater 
and Warren Buffett. What you might not know, is that for each of those filters, there 
is a corresponding ShareScript which allows ShareScope Plus and ShareScope Pro 
customers a greater deal of customisation.

If you have run the filters at one point or another, you’ll have noticed that they rarely return more than a 
handful of shares. This is because the filters, as designed by their various gurus, are extremely strict. If you 
run the script version, however, you’ll be able to relax some of the criteria to obtain a longer list of results.

Let’s look at the Jim Slater filter.

Open a list of shares you’d like to analyse (the full LSE Shares list would do just fine), right-click on the 
column heading area and select Add ShareScript Column.... Press the Script Library button, search for the 
one called Jim Slater’s Zulu and download it.

Once run the initial dialog will look like this:

Each tick-box represents a criterion used in the filter and a positive result (i.e. if the share’s PEG is smaller 
or equal to 1) will add 1 to the share’s score up to a maximum of 9. If you click on OK without making any 
changes the shares with a score of 9 in the column will be the ones that would appear in the results of the 
Data Mining filter. 

One obvious advantage of using the script in a column is that you’ll be able sort the list to see which shares 
have just missed the mark by scoring 7 or 8 out of 9.

Most criteria will have an editable input value, which will allow you to make that criterion more or less strict 
and, if you remove the tick from it, the script will ignore that criterion completely, so the maximum score 
will be reduced by one.

If you are interested in the teachings of the investment gurus we have showcased, downloading the 
corresponding scripts will open a whole new world of possibilities by putting you in full control of their 
filters. Have fun!
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